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ATmega48/88/168 から ATmega48PB/88PB/168PB への移行 
 

 

特長 
 

ATmega48PB/88PB/168PB には以下の複数の特長が新たに追加されています。 

• picoPower®機能 
• 4 本の追加 GPIO ピン 

– 1 組の GND と VCC をなくし、2 本の追加 GPIO ピンに置き換え 
– ADC 入力チャンネルのみを備えていた 2 本のピンを GPIO と多重化 

• USART フレーム開始検出を全てのスリープモードで利用可能 
• ピンへのアナログ コンパレータ出力を追加 
• シリアル番号(一意のデバイス ID)を追加 

 
はじめに 

 

本書では ATmega48/88/168 を新しい ATmega48PB/88PB/168PB に移行する方法を説明します。 

ATmega48PB/88PB/168PB は ATmega48/88/168 と機能的に互換です。本書ではツールチェーン、開発

ツール、IDE を更新する方法を説明します。 

最新の正確な特性とデバイスの詳細は、常に対応するデータシートの最新版を確認してください。エ

ラッタ一覧を確認する事を推奨します。 

最新のデータシートは以下で入手できます。 

• ATmega48/88/168 - http://www.microchip.com/wwwproducts/en/ATmega168 
• ATmega48PB/88PB/168PB - http://www.microchip.com/wwwproducts/en/ATmega168pb 

注意: この日本語版文書は参考資料としてご利用ください。 
最新情報は必ずオリジナルの英語版をご参照願います。 

http://www.microchip.com/wwwproducts/en/ATmega168
http://www.microchip.com/wwwproducts/en/ATmega168pb
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1. ハードウェア設計の互換性 
 
1.1 パッケージタイプ 

サフィックス無し品からサフィックス PB 品への置き換えにあたり、32 ピンの TQFP/VFQFN/MLF の各

パッケージは既存 PCB レイアウトのまま置き換え可能ですが、条件があります。「追加/変更されたピ

ン機能」の章を参照してください。それ以外のパッケージの場合は置き換えに際して PCB レイアウト

変更が必要です。データシートの「Packaging Information」に、各デバイスのフットプリントの寸法と

物理的な図面が掲載されています。各種デバイスと各種パッケージタイプの対応を以下に示します。 

ATmega48/88/168 は以下のパッケージで提供しています。 
• 32 ピン TQFP 
• 32 ピン MLF 
• 28 ピン VQFN 
• 28 ピン PDIP 

ATmega48PB/88PB/168PB は以下の 2 つのパッケージで提供しています。 
• 32 ピン TQFP 
• 32 ピン VFQFN 

 
 
1.2 追加/変更されたピン機能 

ATmega48/88/168 と ATmega48PB/88PB/168PB と互換性のあるパッケージタイプは 2 つあります。本

セクションでは TQFP パッケージタイプのピン配置を比較します。もう 1 つの互換パッケージタイプで

ある MLF/VFQFN については、データシートの「Ordering Information」と「Packaging Information」を

参照してください。 

ATmega48PB/88PB/168PB には 4 本の GPIO ピン(PORTE [3:0])が追加されています。各種ピンの説明

を表 1-1 に示し、各デバイスのピン配置を図 1-1 と図 1-2 に示します。 

32 ピン MLF/VQFN のピン配置は、ATmega48PB/88PB/168PB データシートの「Pin Configurations」
に記載されています。 
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図 1-1. ATmega48/88/168 - 32 ピン TQFP 
 

 
 
 

図 1-2. ATmega48PB/88PB/168PB - 32 ピン TQFP 
 

 
 

PE2 と PE3 の GPIO ピンがピン 19 とピン 22 に追加されました。PE2 と PE3 は ADC6 と ADC7 と多重

化されています。 

ピン 3 (GND)は PE0 に、ピン 6 (VCC)は PE1 に置き換えられました。PE0 は ACO と多重化されていま

す。 
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表 1-1. ピンの機能の相違点 
 

32 ピン TQFP パッケージ ATmega48/88/168 ATmega48PB/88PB/168PB 

ピン 3 GND PE0/ACO 

ピン 6 VCC PE1 

ピン 19 ADC6 ADC6/PE2 

ピン 22 ADC7 ADC7/PE3 

 
ATmega48/88/168 を ATmega48PB/88PB/168PB デバイスにそのまま置き換えて使うには、

以下の条件を満たす必要があります。 

• ピン 3 - GND に接続した場合、このピンを GPIO の出力モード、または ACO を有

効にしてはなりません。 

• ピン 6 - VCC に接続した場合、このピンを GPIO の出力モードにしてはなりません。 
 
 
 
1.3 代替ピンの設定 

代替ピンの設定を以下に示します。 

• ADC7 - ポート E、ビット 3 
PE3 ピンは ADC 入力チャンネル 7 としても使えます。ADC 入力チャンネル 7 はアナログ電源

AVCC を使います。 
• ADC6 - ポート E、ビット 2 

PE2 ピンは ADC 入力チャンネル 6 としても使えます。ADC 入力チャンネル 6 はアナログ電源

AVCC を使います。 
• なし - ポート E、ビット 1 

代替機能なし。 
• ACO – ポート E、ビット 0 

ACO(アナログ コンパレータ出力)ピンは PE0 と多重化されています。 

CAUTION 
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2. コードの互換性 

ATmega48/88/168 は ATmega48PB/88PB/168PB とコードの互換性を維持しています。 

ATmega48/88/168 用に設計されたコードが ATmega48PB/88PB/168PB で確実に実行できるようにする

には、デバイスを変更してコードを再コンパイルする必要があります。 

一般的には、予約済みビットにアクセスする場合は「0」を書き込む必要があります。予約済み I/O メモ

リアドレスには絶対に書き込まない事が必要です。 
 
 
2.1 予約済みレジスタへの書き込み 

従来のコードが予約済みレジスタに書き込みを行っていた場合、Microchip 社はアプリケーションの動

作を保証できません。 

本章は、ATmega48/88/168 用に設計されたコードを ATmega48PB/88PB/168PB で使う場合の注意事項

について説明します。コードが誤って予約済みレジスタまたはビット位置にアクセスした場合も、旧デ

バイスは期待通りに動作するかもしれません。新デバイスでは、これらのレジスタやビットが特定の機

能を持っている可能性があるため、予期しない動作が見られる事があります。 

図 2-1 に示すように、ATmega48/88/168 では、レジスタ位置 0x4F は予約済みです。 

図 2-1. ATmega48/88/168 データシートから抜粋 
 

ATmega48PB/88PB/168PB では、レジスタ位置 0x4F は ACSR0 レジスタです。図 2-2 に示すように、

このレジスタにはピン 3 へのアナログ コンパレータ出力を制御する 1 つのビット、ACOE(アナログ コ
ンパレータ出力イネーブル)が格納されています。 

図 2-2. ATmega48PB/88PB/168PB データシートから抜粋 
 

ACO が誤って有効になり、ATmega48/88/168 を ATmega48PB/88PB/168PB でそのまま置き換えた場

合、ACO は GND に接続されたピンを駆動しようとする可能性があり、予期しない動作となる可能性が

あります。 
 
 
2.2 デバイス ファミリーパック 

ATmega48PB/88PB/168PB のデバイスが完全にサポートされるようにするには、最新のファミリーパッ

クをインストールする必要があります。最新バージョンの Atmel Studio 7.0 には最新のファミリーパック

が含まれています。また、必要に応じて手動でダウンロードする事もできます。方法を以下に示します。 

• Atmel Studio 7.0 のツールバーで[Tools] > [Device Pack Manager]をクリックします。[Device 
Pack Manager]ウィンドウの[ATmega_DFP]で最新バージョンをクリックして選択し、[Install] > 
[Install Selected Packs]をクリックします。 

• [代替方法] http://packs.download.atmel.com/にアクセスし、最新の Atmel ATmega Series Device 
Support をダウンロードします。ダウンロードしたファイルをインストールします。 

http://packs.download.atmel.com/
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3. エコシステム 
AVR®製品のエコシステムには Atmel Studio 7 統合開発環境、AVR 向けツールチェーン、プログラマ、

デバッガ、スタータキットが含まれます。 
 
 
3.1 統合開発環境 

 
3.1.1 Atmel Studio 7 

ATmega48PB/88PB/168PB は、C/C++と Atmel マイクロコントローラのアセンブリコードを開発するた

めの無償の IDE である Atmel Studio 7 の最新バージョンでサポートされています。 

Studio 4 は ATmega48PB/88PB/168PB をサポートしていません。 

最新のインストーラとユーザガイド、その他の関連情報は http://www.microchip.com/development-
tools/atmel-studio-7 を参照してください。 

 
3.1.2 IAR 

ATmega48PB/88PB/168PB は 8 ビット AVR 用の商用 C/C++コンパイラである IAR Embedded 
Workbench® for AVR®でサポートされています。IAR™のユーザは、現在インストールされているバー

ジョンが ATmega48PB/88PB/168PB をサポートしている事を確認する必要があります。 

30 日間の評価版とコードサイズが 4 KB に制限されたキックスタート版があり、ウェブサイト

(https://www.iar.com/iar-embedded-workbench/partners/atmel/)から入手できます。 
 
 
3.2 開発ツール 

ATmega48PB/88PB/168PB では以下の開発ツールを推奨します。 

• Atmel-ICE 

ATmega48PB/88PB/168PB にも対応しているその他のレガシーツールは以下の通りです。 
• AVR Dragon 
• AVR One! 
• AVRISP mkII 
• JTAGICE mkII 
• JTAGICE3 
• Power Debugger 
• QT600 
• STK500 
• STK600 
• Simulator 
• mEDBG 

Atmel Studio 7 で目的のツールを更新するには、以下のようにします。Atmel Studio 7 のツールバーで

[Tools] > [Device Programming]をクリックします。[Device Programming]ダイアログが開いたら、目的

のツール、デバイス、インターフェイスを選択して[Apply]をクリックします。ツールのファームウェア 
バージョンが古い場合、Atmel Studio にツールのファームウェア バージョンを更新するよう表示されま

す。 

http://www.microchip.com/development-tools/atmel-studio-7
http://www.microchip.com/development-tools/atmel-studio-7
https://www.iar.com/iar-embedded-workbench/partners/atmel/
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もう 1 つの方法: Atmel Studio のツールバーで[View] > [Available Tools]をクリックします。[Available 
Tools]ウィンドウで[Tool]を右クリックし、ドロップダウン メニューで[Upgrade]を選択します。 
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4. 新機能 
本章では ATmega48PB/88PB/168PB において ATmega48/88/168 と比べて強化または追加された機能を

まとめます。 

• USART フレーム開始検出モードを全てのスリープモードで利用可能 
• アナログ コンパレータ出力をピンから取り出し可能(このピンは PE0 と多重化されている) 
• シリアル番号(一意のデバイス ID) 
• picoPower 
• ADC 温度計測 

 
4.1 USART 

USART フレーム開始検出回路は、全てのスリープモード中に、スタートビットが検出された時に

ATmega48PB/88PB/168PB をスリープから復帰させる事ができます。 

RxDn で High から Low への遷移が検出されると、内部 8 MHz オシレータが起動して USART クロック

が有効になります。オシレータ起動時間に対して baud レートが十分に低速であれば、内部 8 MHz オシ

レータの起動後にデータフレームの残りの部分を受信できます。内部 8 MHz オシレータの起動時間は電

源電圧と温度によって変化します。 

USART のフレーム開始検出機能は非同期モードでも同期モードでも動作します。この機能は、フレー

ム開始検出イネーブルビット(SFDE)に書き込む事で有効にします。USART 開始割り込みイネーブル

(RXSIE)ビットがセットされていれば、スタートビットが検出されると即座に USART 受信開始割り込

みが生成されます。 

開始割り込みを有効にせずにこの機能を使うと、フレーム受信中にのみ、開始検出ロジックによって内

部 8 MHz オシレータと USART クロックがアクティブ化されます。受信完了割り込みによって MCU が

復帰するまで、その他のクロックは停止されたままになります。 

同期モードの最大 baud レートはデバイスが復帰する前に入っていたスリープモードによって決まりま

す。 

• アイドル スリープモード: システムクロック周波数/4 
• スタンバイまたはパワーダウン: 500 kbps 

非同期モードの最大 baud レートはデバイスが復帰する前に入っていたスリープモードによって決まり

ます。 

• アイドル スリープモード: アクティブモードと同じ 
表 4-1. baud レートの最大総誤差(非倍速モードでの誤差を%単位表記) 

 

baud レート フレームサイズ 

5 6 7 8 9 10 

0～28.8 kbps +6.67 
-5.88 

+5.79 
-5.08 

+5.11 
-4.48 

+4.58 
-4.00 

+4.14 
-3.61 

+3.78 
-3.30 

38.4 kbps +6.63 
-5.88 

+5.75 
-5.08 

+5.08 
-4.48 

+4.55 
-4.00 

+4.12 
-3.61 

+3.76 
-3.30 

57.6 kbps +6.10 
-5.88 

+5.30 
-5.08 

+4.69 
-4.48 

+4.20 
-4.00 

+3.80 
-3.61 

+3.47 
-3.30 
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baud レート フレームサイズ 

5 6 7 8 9 10 

76.8 kbps +5.59 
-5.88 

+4.85 
-5.08 

+4.29 
-4.48 

+3.85 
-4.00 

+3.48 
-3.61 

+3.18 
-3.30 

115.2 kbps +4.57 
-5.88 

+3.97 
-5.08 

+3.51 
-4.48 

+3.15 
-4.00 

+2.86 
-3.61 

+2.61 
-3.30 

 

表 4-2.baud レートの最大総誤差(倍速モードでの誤差を%単位表記) 
 

baud レート フレームサイズ 

5 6 7 8 9 10 

0～57.6 kbps +5.66 
-4.00 

+4.92 
-3.45 

+4.35 
-3.03 

+3.90 
-2.70 

+3.53 
-2.44 

+3.23 
-2.22 

76.8 kbps +5.59 
-4.00 

+4.85 
-3.45 

+4.29 
-3.03 

+3.85 
-2.70 

+3.48 
-2.44 

+3.18 
-2.22 

115.2 kbps +4.57 
-4.00 

+3.97 
-3.45 

+3.51 
-3.03 

+3.15 
-2.70 

+2.86 
-2.44 

+2.61 
-2.22 

 
 
4.2 アナログ コンパレータ 

アナログ コンパレータ制御/ステータス レジスタ C (ACSR0)のアナログ コンパレータ出力イネーブル

(ACOE)に「1」が書き込まれた場合、アナログ コンパレータ出力(ACO)を PE0 に接続できます。 
 
 
4.3 シリアル番号 

各 ATmega48PB/88PB/168PB には、各製品を一意に識別するのに役立つシリアル番号(一意のデバイス

ID とも呼ぶ)が書き込まれています。 

シリアル番号を取得するには 2 通りの方法があります。 

1 つはソフトウェアからシグネチャ行ヒューズを読み出す事です。詳細は、最新のデータシートの

「Reading the Signature Row from Software」を参照してください。 

表 4-3. シグネチャ行ヒューズのアドレス指定 
 

シグネチャバイト Z ポインタのアドレス 

デバイス シグネチャバイト 1 0x0000 

デバイス シグネチャバイト 2 0x0002 

デバイス シグネチャバイト 3 0x0004 

RC オシレータ校正バイト 0x0001 

シリアル番号バイト 1 0x000E 

シリアル番号バイト 0 0x000F 

シリアル番号バイト 3 0x0010 
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C コードサンプル 

uint8_t serial_num[9] = {0}; 

for(uint8_t i = 0; i < 9; i++){ 
serial_num[i] = *((uint8_t *) &DEVID0+i); 

} 

 

シグネチャバイト Z ポインタのアドレス 

シリアル番号バイト 2 0x0011 

シリアル番号バイト 5 0x0012 

シリアル番号バイト 4 0x0013 

シリアル番号バイト 6 0x0015 

シリアル番号バイト 7 0x0016 

シリアル番号バイト 8 0x0017 
 

Note: 
複数のデバイスファミリ間でシリアル番号機能を使う場合、デバイス シグネチャバイトもシリアル番号

に含める必要があります。シリアル番号を 12 バイトの数値に拡張します。 

もう 1 つの方法は I/O アドレス 0xF0～0xF8 を読み出す事です。これは ATmega48PB/88PB/168PB の

シリアル番号は I/O レジスタ SNOBRx を介してアクセスできるためです。シリアル番号は、これらの読

み出し専用レジスタから読み出した 9 バイトを連結する事によって形成されます。詳細は、この後の

「SNOBRx - シリアル番号バイト 8～0」を参照してください。 

以下にシリアル番号を読み出す方法の例を示します。 
 

 

4.3.1 SNOBRx - シリアル番号バイト 8～0 
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4.4 picoPower/電源管理とスリープモード 
AVR® picoPower デバイスの真の価値は、ただ各種 picoPower 機能が含まれている事にあるのではあり

ません。設計手法、プロセスの形状、使われているトランジスタの種類の全てが picoPower デバイスの

省電力機能に欠かせない要素です。全ての picoPower デバイスは、AVR 独自の低リーク電流プロセスと

ライブラリを活用して消費電力を低減し、アクティブモードとあらゆるスリープモードで業界トップレ

ベルの低消費電力を実現するために 1 から設計されています。 

ホワイトペーパー『 Innovative Techniques for Extremely Low Power Consumption with 8-bit 
Microcontrollers』とアプリケーション ノート『AVR4013-picoPower Basics』で picoPower の機能の詳

細を説明しています。 
 

4.4.1 BOD の無効化 
BODLEVEL ヒューズによって BOD(ブラウンアウト検出器)が有効になっている時、BOD はスリープ期

間中の電源電圧を常時監視します。消費電力を削減するため、一部のスリープモードでソフトウェアを

使って BOD を無効にする事ができます。これにより、スリープモードの消費電力が BOD をヒューズで

グローバルに無効化した時と同じレベルになります。BOD がソフトウェアで無効化されている場合、ス

リープモードに入ると即座に BOD 機能が OFF になります。スリープから復帰すると、自動的に BOD
が再有効化されます。これにより、スリープ期間中に VCC が低下した場合でも確実に安全な動作が可能

です。 

BOD が無効化されている場合、BOD が正常に動作してから MCU がコードの実行を継続できるよう、

スリープモードからの復帰時間は約 60 μs になります。 

BOD の無効化は MCU 制御レジスタ(MCUCR.BODS)の BOD スリープビットで制御されます。このビッ

トに「1」を書き込むと関連するスリープモードで BOD が OFF になり、このビットに「0」を書き込む

と BOD がアクティブに維持されます。既定値設定は BODS = 0 で、BOD がアクティブに維持されます。 

Note: BODS ビットへの書き込みは時限シーケンスとイネーブルビットによって制御されます。 

http://www.atmel.com/images/doc7903.pdf
http://www.atmel.com/images/doc7903.pdf
http://www.atmel.com/Images/doc8349.pdf
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5. 更新された機能 
 
5.1 シグネチャバイト 

全ての AVR マイクロコントローラは、デバイスを識別するために 3 バイトのシグネチャコードを備え

ています。このコードの読み出しは、シリアルモードでもパラレルモードでも、デバイスがロックされ

ていても可能です。これら 3 つのバイトは別々のアドレス空間に格納されています。ATmega48/88/168
と ATmega48PB/88PB/168PB ではデバイス シグネチャバイトに違いがあります。詳細は下表を参照し

てください。 

表 5-1. デバイス ID 
 

デバイス シグネチャバイトのアドレス 

0x000 0x001 0x002 

ATmega48/V 0x1E 0x92 0x05 

ATmega48PB 0x1E 0x92 0x10 

ATmega88/V 0x1E 0x93 0x0A 

ATmega88PB 0x1E 0x93 0x16 

ATmega168/V 0x1E 0x94 0x06 

ATmega168PB 0x1E 0x94 0x15 
 
 
5.2 フルスイング オシレータ 

ATmega48/88/168 デバイスにはクロック源オプションとしてフルスイング水晶振動子オシレータが含まれ

ており、フラッシュ ヒューズを設定する事によって選択できました。新しい ATmega48PB/88PB/168PB
にはフルスイング水晶振動子オシレータ オプションが含まれていません。デバイス データシート内の

「Clock Sources」の章を参照してください。 

表 5-2. ATmega48PB/88PB/168PB にはフルスイング オシレータが含まれない 
 

デバイス機能 ATmega48/88/168 ATmega48PB/88PB/168PB 

フルスイング水晶振動子 
オシレータ あり なし 

 
 
5.3 特性 

本章では、電気的仕様と代表的特性における特に大きな変更点について比較します。最新の数値とその

他の数値は、デバイスの最新のデータシートを参照してください。 

最新のデータシートは以下で入手できます。 
• ATmega48PB/88PB/168PB - http://www.microchip.com/wwwproducts/en/ATmega168pb 
• ATmega48/88/168 - http://www.microchip.com/wwwproducts/en/ATmega168 

http://www.microchip.com/wwwproducts/en/ATmega168pb
http://www.microchip.com/wwwproducts/en/ATmega168
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表 5-3. パラレル プログラミングの特性 
 

記号 パラメータ ATmega48/88/168 ATmega48PB/88PB/168PB 単位 

最小 最大 最小 最大 

tWLRH WR の Low 
から RDY/ 
BSY  High 
までの時間 

3.7 4.5 3.2 3.4 ms 

tWLRH_CE チップ消去の

WR の Low 
から RDY/ 
BSY  High 
までの時間 

7.5 9 9.8 10.5 ms 

tBVDV BS1 有効から

DATA 有効 
までの時間 

0 250 0 350 ns 

tOLDV OE  Low か

ら DATA 有効 
までの時間 

0 250 0 350 ns 

表 5-4. 次のフラッシュアドレスまたは EEPROM のアドレスに書き込む前の待機時間(typ.) 
 

記号 ATmega48/88/168 ATmega48PB/88PB/168PB 単位 

tWD_FLASH 4.5 2.6 ms 

tWD_EEPROM 3.6 3.6 ms 

tWD_ERASE 9.0 10.5 ms 

tWD_FUSE - 4.5 ms 
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6. 補足情報と関連文書 

• AVR095: Migrating between ATmega48, ATmega88 and ATmega168 
• AVR512: Migration from ATmega48/88/168 to ATmega48P/88P/168P 
• AVR528: Migrating from ATmega48P/88P/168P to ATmega48PA/88P/168PA 
• AVR532: Migrating from ATmega48/88/168 to ATmega48A/88A/168A 
• AN2519: AVR Microcontroller Hardware Design Considerations 
• AT12615: Getting Started with ATmega48PB/88PB/ 168PB 
• AVR040: EMC Design Considerations 
• AVR053: Calibration of the internal RC oscillator 
• AVR140: ATmega48/88/168 family run-time calibration of the Internal RC oscillator for LIN 

applications 
• AVR910: In-System Programming 
• AVR4013: picoPower Basics 
• AVR4100: Selecting and testing 32kHz crystal oscillators for AVR microcontrollers 
• AVR42787: AVR Software User Guide 

その他の文書は http://www.microchip.com/wwwproducts/en/ATmega168pb を参照してください。 

または、Microchip 社のウェブページ(www.microchip.com)を参照してください。 

http://ww1.microchip.com/downloads/en/appnotes/doc2554.pdf
http://ww1.microchip.com/downloads/en/appnotes/doc2554.pdf
http://ww1.microchip.com/downloads/en/appnotes/doc8035.pdf
http://ww1.microchip.com/downloads/en/appnotes/doc8035.pdf
http://ww1.microchip.com/downloads/en/appnotes/doc8196.pdf
http://ww1.microchip.com/downloads/en/appnotes/doc8196.pdf
http://ww1.microchip.com/downloads/en/appnotes/doc8280.pdf
http://ww1.microchip.com/downloads/en/appnotes/doc8280.pdf
http://ww1.microchip.com/downloads/en/AppNotes/00002519A.pdf
http://ww1.microchip.com/downloads/en/AppNotes/00002519A.pdf
http://ww1.microchip.com/downloads/en/appnotes/atmel-42422-mcu-getting-started-with-atmega168pb-at12615_application-note.pdf
http://ww1.microchip.com/downloads/en/appnotes/atmel-42422-mcu-getting-started-with-atmega168pb-at12615_application-note.pdf
http://ww1.microchip.com/downloads/en/appnotes/atmel-1619-emc-design-considerations_applicationnote_avr040.pdf
http://ww1.microchip.com/downloads/en/appnotes/atmel-1619-emc-design-considerations_applicationnote_avr040.pdf
http://ww1.microchip.com/downloads/en/appnotes/atmel-2555-internal-rc-oscillator-calibration-for-tinyavr-and-megaavr-devices_applicationnote_avr053.pdf
http://ww1.microchip.com/downloads/en/appnotes/atmel-2555-internal-rc-oscillator-calibration-for-tinyavr-and-megaavr-devices_applicationnote_avr053.pdf
http://ww1.microchip.com/downloads/en/appnotes/doc7653.pdf
http://ww1.microchip.com/downloads/en/appnotes/doc7653.pdf
http://ww1.microchip.com/downloads/en/appnotes/doc7653.pdf
http://ww1.microchip.com/downloads/en/appnotes/atmel-0943-in-system-programming_applicationnote_avr910.pdf
http://ww1.microchip.com/downloads/en/appnotes/atmel-0943-in-system-programming_applicationnote_avr910.pdf
http://ww1.microchip.com/downloads/en/appnotes/doc8349.pdf
http://ww1.microchip.com/downloads/en/appnotes/doc8333.pdf
http://ww1.microchip.com/downloads/en/appnotes/doc8333.pdf
http://ww1.microchip.com/downloads/en/appnotes/atmel-42787-avr-software-user-guide_applicationnote_avr42787.pdf
http://ww1.microchip.com/downloads/en/appnotes/atmel-42787-avr-software-user-guide_applicationnote_avr42787.pdf
http://www.microchip.com/wwwproducts/en/ATmega168pb
http://www.microchip.com/
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7. 改訂履歴 

 

文書リビジョン 日付 改訂内容 

A 2017 年 12 月 初版 
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Microchip 社のウェブサイト 

 

Microchip 社はウェブサイト(http://www.microchip.com/)でオンライン サポートを提供しています。当

ウェブサイトでは、お客様に役立つ情報やファイルを簡単に見つけ出せます。インターネット ブラウザ

から以下の内容がご覧になれます。 

• 製品サポート - データシートとエラッタ、アプリケーション ノートとサンプル プログラム、設計リ

ソース、ユーザガイドとハードウェア サポート文書、最新のソフトウェアと過去のソフトウェア 
• 技術サポート – よく寄せられる質問(FAQ)、技術サポートのご依頼、オンライン ディスカッショ

ン グループ、Microchip 社のコンサルタント プログラムおよびメンバーリスト 
• ご注文とお問い合わせ - 製品セレクタと注文ガイド、最新プレスリリース、セミナー/イベントの

一覧、お問い合わせ先(営業所/販売代理店)の一覧 
 

お客様向け変更通知サービス 
 

Microchip 社のお客様向け変更通知サービスは、お客様に Microchip 社製品の最新情報をお届けする配信

サービスです。ご興味のある製品ファミリまたは開発ツールに関連する変更、更新、エラッタ情報をい

ち早くメールでお知らせします。 

Microchip 社ウェブサイト (http://www.microchip.com/)にアクセスし、 [Support]の [Product Change 
Notification]からご登録ください。 

 
お客様サポート 

 

Microchip 社製品をお使いのお客様は、以下のチャンネルからサポートをご利用頂けます。 

• 正規代理店 
• 技術サポート 

サポートは正規代理店にお問い合わせください。本書の最後のページに各国の営業所の一覧を記載して

います。 

技術サポートは以下のウェブページからもご利用になれます。http://www.microchip.com/support 
 

Microchip 社のデバイスコード保護機能 
 

Microchip 社製品のコード保護機能について以下の点にご注意ください。 
• Microchip 社製品は、該当する Microchip 社データシートに記載の仕様を満たしています。 
• Microchip 社では、通常の条件ならびに動作仕様書の仕様に従って使った場合、Microchip 社製品

のセキュリティ レベルは、現在市場に流通している同種製品の中でも最も高度であると考えてい

ます。 
• Microchip 社はその知的財産権を重視し、積極的に保護しています。Microchip 社製品のコード保

護機能の侵害は固く禁じられており、デジタル ミレニアム著作権法に違反します。 
• Microchip 社を含む全ての半導体メーカーで、自社のコードのセキュリティを完全に保証できる企

業はありません。コード保護機能とは、Microchip 社が製品を「解読不能」として保証するもので

はありません。コード保護機能は常に進化しています。Microchip 社では、常に製品のコード保護

機能の改善に取り組んでいます。 

http://www.microchip.com/
http://www.microchip.com/
http://www.microchip.com/support
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法律上の注意点 
 

本書および本書に記載されている情報は、Microchip 社製品を設計、テスト、お客様のアプリケーション

と統合する目的を含め、Microchip 社製品に対してのみ使う事ができます。それ以外の方法でこの情報を

使う事はこれらの条項に違反します。デバイス アプリケーションの情報は、ユーザの便宜のためにのみ

提供されるものであり、更新によって変更となる事があります。お客様のアプリケーションが仕様を満

たす事を保証する責任は、お客様にあります。その他のサポートはMicrochip 社正規代理店にお問い合わ

せ頂くか、https://www.microchip.com/en-us/support/design-help/client-support-servicesをご覧ください。 

Microchip 社は本書の情報を「現状のまま」で提供しています。Microchip 社は明示的、暗黙的、書面、

口頭、法定のいずれであるかを問わず、本書に記載されている情報に関して、非侵害性、商品性、特定

目的への適合性の暗黙的保証、または状態、品質、性能に関する保証をはじめとするいかなる類の表明

も保証も行いません。 

いかなる場合もMicrochip 社は、本情報またはその使用に関連する間接的、特殊的、懲罰的、偶発的また

は必然的損失、損害、費用、経費のいかんにかかわらず、またMicrochip 社がそのような損害が生じる可

能性について報告を受けていた場合あるいは損害が予測可能であった場合でも、一切の責任を負いませ

ん。法律で認められる最大限の範囲を適用しようとも、本情報またはその使用に関連する一切の申し立

てに対するMicrochip 社の責任限度額は、使用者が当該情報に関連してMicrochip 社に直接支払った額を

超えません。 

Microchip 社の明示的な書面による承認なしに、生命維持装置あるいは生命安全用途にMicrochip社の製品

を使う事は全て購入者のリスクとし、また購入者はこれによって発生したあらゆる損害、クレーム、訴

訟、費用に関して、Microchip 社は擁護され、免責され、損害をうけない事に同意するものとします。特

に明記しない場合、暗黙的あるいは明示的を問わず、Microchip社が知的財産権を保有しているライセン

スは一切譲渡されません。 
 

商標 
 

Microchip 社の名称とロゴ、Microchip ロゴ、Adaptec、AVR、AVRロゴ、AVR Freaks、BesTime、
BitCloud、CryptoMemory、CryptoRF、dsPIC、flexPWR、HELDO、IGLOO、JukeBlox、KeeLoq、Kleer、
LANCheck、LinkMD、maXStylus、maXTouch、MediaLB、megaAVR、Microsemi、Microsemi ロゴ、

MOST、MOST ロゴ、MPLAB、OptoLyzer、PIC、picoPower、PICSTART、PIC32 ロゴ、PolarFire、
Prochip Designer 、 QTouch 、 SAM-BA 、 SenGenuity 、 SpyNIC 、 SST 、 SST ロゴ、 SuperFlash 、

Symmetricom、SyncServer、Tachyon、TimeSource、tinyAVR、UNI/O、Vectron、XMEGA は米国とその

他の国におけるMicrochip TechnologyIncorporated の登録商標です。 

AgileSwitch、APT、ClockWorks、The Embedded Control SolutionsCompany、EtherSynch、Flashtec、
Hyper Speed Control、HyperLightLoad、Libero、motorBench、mTouch、Powermite 3、Precision Edge、
ProASIC、ProASIC Plus、ProASIC Plus ロゴ、Quiet-Wire、SmartFusion、SyncWorld、Temux、
TimeCesium 、 TimeHub 、 TimePictra 、 TimeProvider 、 TrueTime 、 ZL は米国における Microchip 
Technology Incorporated の登録商標です。 

Adjacent Key Suppression、AKS、Analog-for-the-Digital Age、Any Capacitor、AnyIn、AnyOut、
Augmented Switching 、 BlueSky 、 BodyCom 、 Clockstudio 、 CodeGuard 、 CryptoAuthentication 、

CryptoAutomotive 、 CryptoCompanion 、 CryptoController 、 dsPICDEM 、 dsPICDEM.net 、 Dynamic 
Average Matching、DAM、ECAN、Espresso T1S、EtherGREEN、GridTime、IdealBridge、In-Circuit 
Serial Programming、 ICSP、 INICnet、 Intelligent Paralleling、 IntelliMOS、 Inter-Chip Connectivity、
JitterBlocker、Knob-on-Display、KoD、maxCrypto、maxView、memBrain、Mindi、MiWi、MPASM、

MPF、MPLAB Certified ロゴ、MPLIB、MPLINK、MultiTRAK、NetDetach、Omniscient Code Generation、

https://www.microchip.com/en-us/support/design-help/client-support-services
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PICDEM 、 PICDEM.net 、 PICkit 、 PICtail 、 PowerSmart 、 PureSilicon 、 QMatrix 、 REAL ICE 、

RippleBlocker、RTAX、RTG4、SAM-ICE、Serial Quad I/O、simpleMAP、SimpliPHY、SmartBuffer、
SmartHLS、SMART-I.S.、storClad、SQI、SuperSwitcher、SuperSwitcher II、Switchtec、SynchroPHY、

TotalEndurance、Trusted Time、TSHARC、USBCheck、VariSense、VectorBlox、VeriPHY、ViewSpan、
WiperLock、XpressConnect、ZENAは米国とその他の国におけるMicrochip Technology Incorporated の
商標です。 

SQTP は米国におけるMicrochip Technology Incorporated のサービスマークです。 

Adaptec ロゴ、Frequency on Demand、Silicon Storage Technology、Symmcom はその他の国における

Microchip Technology Incorporatedの登録商標です。 

GestIC は、その他の国におけるMicrochip Technology Germany II GmbH & Co. KG (Microchip 
Technology Incorporated の子会社) の登録商標です。 

その他の商標は各社に帰属します。 

© 2023, Microchip Technology Incorporated and its subsidiaries. 

All Rights Reserved. 

ISBN: 978-1-6683-1789-1 
 

DNV による品質管理システム認証 
 

 

ISO/TS 16949 
Microchip 社では、Chandler および Tempe(アリゾナ州)、Gresham(オレゴン州)の本部、設計部および

ウェハー製造工場そしてカリフォルニア州とインドのデザインセンターが ISO/TS-16949:2009 認証を取

得しています。Microchip 社の品質システムプロセスおよび手順は、PIC® MCU および dsPIC® DSC、

KEELOQ®コードホッピング デバイス、シリアル EEPROM、マイクロペリフェラル、不揮発性メモリ、

アナログ製品に採用されています。さらに、開発システムの設計と製造に関する Microchip 社の品質シ

ステムは ISO 9001:2000 認証を取得しています。 
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各国の営業所とサービス 
 

 

南北アメリカ アジア/太平洋 アジア/太平洋 欧州 

本社 
2355 West Chandler Blvd. 
Chandler, AZ 85224-6199 
Tel: 480-792-7200 
Fax: 480-792-7277 
技術サポート: 
http://www.microchip.com/support 
URL: 
www.microchip.com 
アトランタ 
Duluth, GA 
Tel: 678-957-9614 
Fax: 678-957-1455 
オースティン、TX 
Tel: 512-257-3370 
ボストン 
Westborough, MA 
Tel: 774-760-0087 
Fax: 774-760-0088 
シカゴ 
Itasca, IL 
Tel: 630-285-0071 
Fax: 630-285-0075 
ダラス 
Addison, TX 
Tel: 972-818-7423 
Fax: 972-818-2924 
デトロイト 
Novi, MI 
Tel: 248-848-4000 
ヒューストン、TX 
Tel: 281-894-5983 
インディアナポリス 
Noblesville, IN 
Tel: 317-773-8323 
Fax: 317-773-5453 
Tel: 317-536-2380 
ロサンゼルス 
Mission Viejo, CA 
Tel: 949-462-9523 
Fax: 949-462-9608 
Tel: 951-273-7800 
ローリー、NC 
Tel: 919-844-7510 
ニューヨーク、NY 
Tel: 631-435-6000 
サンノゼ、CA 
Tel: 408-735-9110 
Tel: 408-436-4270 
カナダ - トロント 
Tel: 905-695-1980 
Fax: 905-695-2078 

オーストラリア - シドニー 
Tel: 61-2-9868-6733 
中国 - 北京 
Tel: 86-10 -8569-7000 
中国 - 成都 
Tel: 86-28-8665-5511 
中国 - 重慶 
Tel: 86-23-8980-9588 
中国 - 東莞 
Tel: 86-769-8702-9880 
中国 - 広州 
Tel: 86-20-8755-8029 
中国 - 杭州 
Tel: 86-571-8792-8115 
中国 - 香港 SAR 
Tel: 852-2943-5100 
中国 - 南京 
Tel: 86-25-8473-2460 
中国 - 青島 
Tel: 86-532-8502-7355 
中国 - 上海 
Tel: 86-21-3326-8000 
中国 - 瀋陽 
Tel: 86-24-2334-2829 
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